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GENERAL NAVIGATION 
In the following sections you will learn to… 

• Launch Hyperion Workspace 
• Set General and Explore preferences 
• Open Planning applications 
• Add favorites 
• Printing Reports  

Launching Hyperion Workspace 
To start Planning, you log on to Hyperion Workspace with your user name and password.  

1. Navigate to Hyperion Workspace: https://encore.ok.gov 
2. Enter User Name and Password 
3. Click “Log On” 
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Opening Hyperion SOK PLAN 

 

1. Click the Navigate menu. 
2. Click the Applications menu. 
3. Click the Planning menu. 
4. Select SOKPLAN application 

 Changing Password 
1. Click the Tools menu. 

 

 

2. Click the Change Password menu. 
3. Enter the desired information into the Current Password 
4. Enter the desired information into the New Password 
5. Enter the desired information into the Confirm Password 
6. Click the Save button. 

  

Hyperion Exercise Guide: Line Item  Page 4 of 45 
September 2014    



  

                            OMES – Project Encore 
                                                      Training Manual 

 
Setting Preferences and Favorites 

The first time you log into Hyperion you will need to set your preferences. 

Setting Preferences  

1. Open SOK PLAN  

 

2. Click the File menu. 

 

3. Click the Preferences 
4. Click the Planning icon 
5. Click on 4th tab called “User Variable Options”  
6. Set the Dimensions according to year you will need choose the (...) icon, to make changes 
7. Click the Save Button 
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Adding Favorites 
Favorites enable you to quickly access frequently used items and documents.  

 

1. Go to Explore Button 
2. Click the + sign by SOK PLAN  
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 3. Select folder or form to be placed in favorites ie. Capital Planning, Human Capital Planning.  

 

4. Click the Favorites menu. 
5. Click the Add to Favorites list item. 

 

***Notice that the folder is now listed as a favorite. ***You successfully added a folder to your 
favorites. 

Hide View Pane and Content Area 
For a maximum view of content area user can hide view pane 

1. Click the Collapse Pane button. 

 

2. The View pane is hidden and the content area page is expanded. 
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REPORTS 

Navigation to Reports Folders  
To run reports, you will first need to navigate to the Explore workspace at the top-left of the 
screen: 

  

Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally 
the Budget Request Reports folder: 
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Operational Planning Reports  

• Operational Planning - Provide or verify Agency Information 

 Report Name: Agency-Organizational Information 

• Operational Planning - Provide Agency Program Information 

 Report Name: Program Information-Performance Measures 

• Operational Planning - Identify Legislation Needs 

 Report Name: Legislation Needs 

• Operational Planning - Operational Decision Package 

 Report Name: Decision Package Detail Report 
This report is located in a different place than the other reports. Details are on Page 8 

 

Strategic Planning Reports  
• Strategic Planning - Provide Executive Summary 

 Report Name: Strategic Plan Report 

• Strategic Planning – Goal Setting  

 Report Name: Strategic Plan Report KPMs 
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Operational Planning – Provide or verify Agency 
Information 
Report Name: Agency-Organizational Information 

To run this report, you will first need to navigate to the Explore workspace at the top-left of the 
screen: 

 

Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally 
the Budget Request Reports folder: 

 

Then double-click on the Agency-Organizational Information report to start it: 
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A new page will open with a prompt: 

Make sure the ‘Edit Member Names’ checkbox is checked to allow for typing in the Selection 
field: 
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Then type in your agency number (use the full 5 digits): 

 

Then hit the OK ( )button to run the report. Once run, the report should come up within 
Hyperion: 

 

Hyperion Exercise Guide: Line Item  Page 12 of 45 
September 2014    



  

                            OMES – Project Encore 
                                                      Training Manual 

 
To turn that report into a PDF file, click on the PDF icon ( ) at the top-left of the screen: 

 

The PDF file will open within Hyperion. You can then print it using the Print icon ( ) at the top-right 
of the screen: 

  

Or you can download it and save it using the Download button ( ), also at the top-right of the 
screen. 
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Operational Planning – Provide Agency Program 
Information 
Report Name: Program Information-Performance 
Measures 

To run this report, you will first need to navigate to the Explore workspace: 

 

Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally 
the Budget Request Reports folder: 

 

Then double-click on the Program Information-Performance Measures report to start it: 
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A new page will open with a prompt: 

 

Make sure the ‘Edit Member Names’ checkbox is checked to allow for typing in the Selection 
field: 
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Then type in your agency number (use the full 5 digits): 

 

Then hit the OK ( ) button to run the report. Once run, the report should come up within 
Hyperion: 

 

If information was entered at multiple levels (i.e. at the Department, Division, or Agency level), 
then that data can be viewed by selecting the appropriate entity from the dropdown box located in 
the middle of the report: 
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To turn that report into a PDF file, click on the PDF icon ( ) at the top-left of the screen: 

 

The PDF file will open within Hyperion. If information was entered at multiple levels, the PDF of 
the report should show all of them. The entity will be shown at the top left of the report. This 
example will be for the division level entity of 41500_10: 
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You can then print it using the Print icon ( ) at the top-right of the screen: 

 

Or you can download it and save it using the Download button ( ), also at the top-right of the 
screen. 
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Operational Planning – Identify Legislation Needs 
Report Name: Legislation Needs 

To run this report, you will first need to navigate to the Explore workspace at the top-left of the 
screen: 

 

Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally 
the Budget Request Reports folder: 

 

Then double-click on the Legislation Needs report to start it: 
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A new page will open with a prompt: 

  

Then type in your agency number (use the full 5 digits): 
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Then hit the OK ( ) button to run the report. Once run, the report should come up within 
Hyperion: 

 

If information was entered at multiple entities (i.e. at the Department 9000001, 9000002, etc.), 
then that data can be viewed by selecting the appropriate entity from the dropdown box located in 
the middle of the report: 
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To turn that report into a PDF file, click on the PDF icon ( ) at the top-left of the screen: 

 

The PDF file will open within Hyperion. You can then print it using the Print icon ( ) at the 
top-right of the screen: 
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Or you can download it and save it using the Download button ( ), also at the top-right of the 
screen. 

Operational Planning – Operational Decision 
Package 
Report Name: Decision Package Detail Report 

To run this report, you will first need to go to the SOKPLAN application. You can do this by going 
to the Navigate menu at the top-left of the screen: 
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 Once in the SOKPLAN application, you will need to go to the Tools menu at the top-left of the 
screen, then select the Reports option. 

 

Once the Reports option is selected, a new screen should appear in Hyperion with a Decision 
Package tab:  
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 In order to run the reports, you will first need to select the appropriate point-of-view (POV): 

 

For the FY16 Budget Requests, here are the selections you will need to make: 

 

Then load the POV by selecting the Go button ( ). Once loaded, the Available Decision 
Packages portion of the screen should populate with the decision packages your agency has 
created: 

 

Select the package you wish to run the report for by checking the checkbox next to it: 
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Then move it over to the Selected Decision Packages portion by hitting the Move button ( ): 

 

Once it is selected, choose the Detail report option from the dropdown list on the Decision 
Package Listing:  

 

Then proceed to click the Create Report ( ) button listed at the bottom-right hand 
of the screen. Doing so will prompt you with a window asking if you would like to save the report, 
or open it as a PDF: 
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 If you have Adobe Reader, it should then open a window with your Decision Package Detailed 
report: 
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Strategic Planning – Provide Executive Summary  
Report Name: Strategic Plan Report 

To run this report, you will first need to navigate to the Explore workspace at the top-left of the 
screen: 

 

Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally 
the Budget Request Reports folder: 

 

Then double-click on the Strategic Plan report to start it: 
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A new page will open with a prompt: 

 

Then type in your agency number (use the full 5 digits): 
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Then hit the OK ( ) button to run the report. Once run, the report should come up within 
Hyperion: 
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 This report will pull data entered in other portions of Hyperion, including the Provide or verify 

Agency Information task. To turn that report into a PDF file, click on the PDF icon ( ) at the 
top-left of the screen: 

 

The PDF file will open within Hyperion. You can then print it using the Print icon ( ) at the 
top-right of the screen: 

 

Or you can download it and save it using the Download button ( ), also at the top-right of the 
screen. 
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Strategic Planning – Goal Setting  
Report Name: Strategic Plan Report KPMs 

To run this report, you will first need to navigate to the Explore workspace at the top-left of the 
screen: 

 

Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally 
the Budget Request Reports folder: 

 

Then double-click on the Strategic Plan Report KPMs to start it: 
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A new page will open with a prompt: 

 

Then type in your agency number (use the full 5 digits): 
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Then hit the OK ( ) button to run the report. Once run, the report should come up within 
Hyperion: 

 

To turn that report into a PDF file, click on the PDF icon ( ) at the top-left of the screen: 

 

The PDF file will open within Hyperion. You can then print it using the Print icon ( ) at the 
top-right of the screen: 
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Or you can download it and save it using the Download button ( ), also at the top-right of the 
screen. 
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ADDITIONAL NAVIGATION TOOLS 

Printing and Saving Reports with Internet Explorer 
There are some slight discrepancies when using Mozilla Firefox and Internet Explorer. When 
trying to save a PDF in Internet Explorer, you can simply go to the Internet Explorer File menu 
and select Save as…: 

 

However, in order to directly print a PDF straight from Hyperion, you will need to hover your 
mouse cursor over the PDF so that the following menu appears on the PDF: 
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The Save button ( ) will also allow for the saving of the reports, and the Print button ( ) 
will let you print the report directly from Hyperion. 

Importing Documents  
To Import a file, you will first need to navigate to the Explore workspace by clicking on the Explore 
button at the top-left of the screen: 

 

Navigate to your agency’s Budget Supporting Documents folder and double click. 
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 Right click on your agency’s folder or in the white-space on the right side of the screen, and 
Import a File: 

 

Choose the file you wish to import by Browsing ( ) to the location of the file on your 
computer: 

 

Be sure to hit the Next button and not the Finish button: 

 

You don’t have to adjust any of the Advanced option if you don’t want to, so hit the Next button 
again.  

On the Permissions screen, you will choose who can access, view, or modify the attachment. 
This is done by assigning access to individual users, user groups, or user roles to the document. 
The easiest might be to assign access to groups. 

You will first need to search for the groups by clicking on the Groups tab: 
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Then go to the bottom and change the search feature from “begin with” to “contain”: 

 

Then type in your agency number to find your agency’s groups, or “all” to find the All Agency 
groups. For example: 
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LI is for the Operational Planning & Strategic Planning modules, HCP is for the Position Budget 
module, and Capital is for the Capital Budget module. 

All Agencies groups are your OMES Budget and Capital analysts. Agencies also have their own 
module groups. 

Then select the group and add them to the allowed groups: 
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 In order for users of those groups to view or access the attachment, they will need to be given 
access to it. To assign that access, you will need to click in the Access column on the screen:  

 

Once that is done, then you can apply these default permissions to any file you import, if you 
want to: 

 

Once Imported into Hyperion, and then right click on the cell you wish to attach the file to and 
choose the Document Attachments option: 

 

Hit the Plus sign to add a new attachment, either by using the shortcut or by selecting that option 
from the Action menu: 
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Type in a description for the attachment, and then select the Browse to Workspace button 
underneath the Reference box: 

 

Search for your agency’s Budget Supporting Documents folder, and select the imported file you 
wish to attach. Then hit the OK button. 

After that, the file has been attached to that particular cell and should be noted by a green tab 
type object in the upper right-hand side of the cell (similar to Excel signifying a comment with a 
red tab type object on a cell). However, it might still be wise to make a note in the cell that there is 
an attached document, just in case the reviewer’s eyes miss the little green tab type object. 

  

Hyperion Exercise Guide: Line Item  Page 42 of 45 
September 2014    



  

                            OMES – Project Encore 
                                                      Training Manual 

 
Adding Comments 

Comments are a useful feature for identity data that is entered in fields.  

1. Click the Navigate menu. 
2. Click the Applications menu. 
3. Click the Planning menu. 
4. Click the SOKPLAN menu. 
5. Go to My Task List. 
6. Click any  task list form ie. Operational Planning-Plan Agency Revenue to add 

comments. 
7. Right-click the any cell where the comment is to be inserted. 
8. Choose “Comments” 

 

9. Click Action drop down button, then Add button  OR click +   

 

10. Enter the desired information into the Comment field.  
11. Click the Add button. 
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12. Click the Close button. 
13. Green Indicator in top right corner of cell lets user know there is a comment for that cell. 

Copy/ Paste Option 
To copy from an external document.  ie. Word and paste into cells in Hyperion.  

Select Ctrl + C: this copies the selected range of cells to the clipboard then Select Ctrl + V: 
Pastes content from Clipboard into cells in Hyperion. 

Complete Button 
For each listed task in the side menu users have the ability to keep track of their progress as they 
move through each budget process. These buttons also help users to advance to the next task, 
go to previous task, go to previous or next incomplete tasks and navigate back to the Task List 
Home page.  
**This complete box is NOT a required option. It is intended for the user to keep track of their 
progress. 
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 On the task list home page, once a user checks the complete button Hyperion will keep track 
which tasks have been complete with a pie chart, indicating Incomplete, Complete and for items 
that have dues dates and Overdue status color.  
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